
SELF-PUBLISHING
WHAT YOU SHOULD PROBABLY KNOW BEFORE YOU TAKE THE PLUNGE



Welcome!

 What is publishing?

 What does self-publishing mean?

 What if I don’t want to publish, I just want to make a book?

 A most unusual study group format

 Formatting your interior

 Font choices

 Using styles and direct formatting

 Interior Typesetting

 barbrude.wordpress.com/self-publishing/olli-study-group/



What is publishing?

 Making a piece of intellectual property available to the general public. Writing 
a blog is publishing. Instragram is publishing. Handing out a ‘zine is publishing.

 When we talk about book publishing, there are a few ways to make a book 
available to the general public

 Trade publishing. Author licenses copyright to larger company, who publishes 
(produces and distributes) book using employees and contractors.

 Self-publishing. Author produces and distributes book utilizing services and 
contractors.

 New technologies in computing, printing, and digital reading have made self-publishing a 
viable option. Self-published books can have the same quality as big name books.

 New print-on-demand technology allows self-publishers to list books for sale online and order 
copies on a per-order basis without paying thousands of dollars upfront for the privilege of 
storing hundreds of books in your garage.



What if I just want to make a book?

 You absolutely can make a book without making it available for sale.

 When you order from a printing company like Versa Press, PipCo Printing or 
Speedy, you get the copies you ordered and they do not make it available for 
purchase by others

 Createspace, a print-on-demand company, allows you to purchase copies 
without listing the book for sale.

 These books can come in several sizes and two paper colors. They are perfect bound 
trade paperback books.

 Print-on-demand means the books are created once the order is made. A large 
machine called an Espresso Book Maker prints, binds, and cuts each copy to order.

 For this study group, we’ll be focusing on Createspace, but the templates and 
guidelines we will use meet the requirements for other printers.



Why Createspace?

 We’re focusing on Createspace because after all my self-publishing research, it’s the one I 
chose to use myself.

 Easy to use

 Affordable

 Reliable

 Distribution is automatic

 Other print-on-demand companies offer similar services, but charge higher fees, including fees per 
mistake/file change, which can make the learning process very expensive

 I tried getting some quotes from local printers.

 Only a few in the area can make perfect bound books

 Half of them never responded to my request for quote

 The quotes came in at a high set up cost, making the per unit cost much higher than using an online print-
on-demand service

 Offset printers like Versa Press create high-quality books but they have a minimum of 300 books for a print 
run—for $2,000. This does not include extra costs if your file is not print ready, and does not provide you an 
ISBN (barcode number) for your book.

 Using a local or offset printer does not list your book online—you will have to set up your own website or 
create a vender page on other sales sites to list your book.



Self-Printed or Self-Published?

 Self-printed: if you don’t want the book online for sale to the general public, 
you can do whatever you wan! Your favorite photograph on the cover, 
personal stories inside, no page numbers, different fonts for everything, a rant 
about how your sister ruined Thanksgiving that one time back in ’97

 Self-published: if your book is going to be available to the general public, you 
need to understand and comply with copyright laws. Do you own the rights to 
your cover photo/design? Have you gotten written consent to publish those 

personal stories from the people named in them? Have you avoided libel? Is 
the book edited and does it have market appeal? Are you willing to learn the 
industry to properly categorize your book and understand your target 
audience? Is it properly formatted with good typography and is the content 
well-organized? Do you have the appropriate citations or disclaimers?



Honest Answers to Hard Questions

 What do I want out of this?

 What’s the best way to achieve my goals?

 Have I researched the market to see where my book fits in?

 Is the manuscript ready? No, really—is it ready?

 Do I understand copyright law?

 What can I do myself and what do I need to seek help with?

 Where will I find that help? Can my mother really edit my book? How much should I pay a 
professional editor?

 Am I prepared for 1-star reviews and months with no new sales?

 Am I prepared for success?

 Am I prepared to learn from my mistakes and failures?

 Do I have a business mindset and a business plan?



I’m terrified—now what?

 There’s a lot to consider and a lot you might not know.

 Take a deep breath! Self-publishing is a lot of big decisions, and you don’t 

have to make any of them today.

 Let’s begin setting up your book for self-printing or self-publishing. Once 

you’re sure the book is ready, you can publish it. If you want.

 We’ll talk more about formats, copyrights, promotion, and self-publishing 

particulars in the near future. For now, let’s get started making your book 

look like a book!



An Unusual Group Format

 Because our lab sessions are front-loaded, we need to make good use of 

our computer time

 The good news: we can start formatting your novel for print today

 The bad news: you might have a lot of questions that we won’t be addressing 

until our session next week

 Scams & Avoiding Them

 Copyright

 Hiring out help

 Marketing & Self-Promotion



Formatting your book for Print, A 

QUICK Overview

 You can use a template or format your document directly to print readiness

 Templates are pre-formatted. You use a special paste command to bring your book 
into the template file, piece by piece

 Do NOT use the space bar, tabs, or hard returns to add white space. Use 
formatting (alignment, margins, first line indent, and breaks).

 If you have wayward tabs and hard returns in your book, it can wreak havoc on your 
layout

 Two ways to format text: direct formatting and styles.

 For paragraph, line spacing, font and size, alignment, use styles.

 For italicizing, hyperlinking, and bolding, use direct formatting.

 Change paper size and margins for your book size. Change gutter margins for 
book length. (Page Layout tab > more paper sizes ).

 Insert headers and footers and format them.



I hit the hard return 80 times for my 

chapter break, now what?

 If you need to get rid of wayward 

spaces, use the show all characters 

command

 File > Options > Display

 A clean document is pivotal to 

saving yourself headaches.



Clean up

 You will want to clean up any of the 

extra hard returns and tabs you see in 

your document

 If you want to format this document 

for eBooks as well, you will want no 

tabs in your file

 Tabs create weird problems in coded 

documents

 There’s a command you can use to 

search all/remove all tabs



Removing Tabs or Other Characters

 Find and replace all

 Leave the “replace” field blank to delete instead of replace

 You can use formatting to indent your paragraphs without using tabs

 Exception: poetry



Find & Replace for Tabs

 Click on “more > >” to open up these 

extra formatting options

 Find tabs and other special characters 

in the “Special” menu at the bottom o 

the Find & Replace menu

 You can use styles & formatting to add 

indentations into your paragraphs 

without using tabs



Using Styles in Word Processors

 Styles format sections of text consistently and quickly.

 To apply a style, select the text and choose the style that makes the most 

sense (Normal or Text Body for the main text, Heading 1 and Titles for 

headings and titles).

 Modify the style so it matches the look you want for your book—first line 

indent, font, size, paragraph alignment and spacing.

 Apply a style to every piece of text in your book.

 Styles are important for consistency (a full-length novel is 200+ pages, 

which is a lot to work with) and preserving the format during the upload 

and conversion processes.



Using Styles in Word, Some Visuals

To bring up the styles 

box, use shortcut 

command

Control + Shift + S



Recommended Fonts

 Recommended book fonts

 Garamond

 Caslon

 Palatino

 Baskerville Old Face

 Georgia

 Bembo*

 Minion*

 Janson*

 These fonts are serif, which means they have different stroke widths and serifs (the pointy things on the 
letters).

 Research has shown that serif is easier to read for printed documents and that sans serif (like Calibri, 
used in this presentation) is easier/less straining for digital or screen reading.

 When choosing a font for print, print out a sample! Computer displays are light-based, which affects 
how the eye interprets the shapes. A printout will show you exactly what you’re getting.



More Styling 

in Word

First line indentation will 

automatically indent the first line of 

every paragraph.

If you do not want paragraph 

indentations, consider adding 

space between each paragraph

Consider line spacing at 1 line or 

something similar



Paragraphs and Alignment

 Books most often use 

‘justified’ (also known as 

full) alignment, which 

means the words in a 

paragraph are 

stretched/scrimped to 

become a block of text



Kerning, A Typesetting Tool

Four administration buildings –
with kerning

Four administration buildings –
no kerning
 Kerning is how the letters are spaced together. Word processors operate like old typewriters—each 

letter gets the same space before and after, unless you activate kerning. Kerning is ‘smart’ and will 
take some of those tiny extra spaces out so that your printed material reads much smoother.

 The difference is tiny—your reader may not notice at all, but it’s an important tool that makes your 
text easier to read and look more professional.



Enable kerning in your Normal style

Access this dialog box through Modify Style >

Format > Font...

Click on the Advanced Tab

The “points” refers to font size.



Put every character in a style

 If your document is mostly styled, it might be quicker to change the font in 

your styles to something dramatically different and scroll for text that does 

not match, and apply the styling to that mismatched text

 If your document has never been styled or is a hot mess of formatting 

(likely for your first go-through), the fastest method might be a ‘nuclear’ 

method

 Select All of your document (Select > All or Control + A)

 Select “Normal” style

 Comb through your document for chapter headings and subheadings and 

apply the correct style as you see them



How Many Styles Do You Need?

 At minimum, you’ll want two styles

 Normal (or Default Style) for the bulk of your text

 Heading 1 (or Heading) for chapter titles or parts

 I use four styles

 Normal

 Heading 1 (chapters)

 Heading 2 (scene breaks)

 End Matter (similar to Normal style, but without paragraph indentations and uses 
ragged left alignment instead of justified)

 Non-fiction may need more, but be consistent and streamline whenever 
possible



Using Templates

 If you download a template, you’ll take the placeholder text in the book file 
and replace it with your own.

 For some text, it may be faster to type it in than copy it (the title, the date in the 
copyright notice, the author name)

 For your text, you’ll want to copy it in using the copy and paste commands:

 Select Text in manuscript

 Copy (Ctrl C)

 Return to template document and right click on mouse

 Use “Keep Text Only” paste command to apply new document’s style to your text

 Read through to make sure the style has been applied consistently



Paste as Text Only



Homework

 Wednesday we will continue on with more formatting—margins, page size, 
images, headers

 Bring images (if any) on a flash drive or have them ready in your email

 Images should be high quality (300 dpi)

 Decide on book (trim) size

 Keep applying styles to your manuscript

 Pull a few books off your shelves to study book design. Look at which 
pages have page numbers, how the books utilize headers and footers, 
and other details you might have never noticed before.

 If you have a great example you want to emulate, bring it!


